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1. Basics of UV Measurement 
 

Congratulations!  As a PowerView Software® III user, you have made a strong commitment to accurate 

and reproducible UV measurement by purchasing one of the finest and most popular tools available.  The 

EIT2.0 PowerView Software® III application provides data analysis and file sharing capabilities for your 

PowerMAP II, LEDCure Profiler, Power Puck II Profiler and/or UviCure Plus II Profiler instruments.  

Note: This manual uses the term “Profiler” to indicate Profiler versions of the LEDCure, Power Puck II and 

UviCure Plus II.  

This section is intended to be a quick explanation of the basic principles of UV measurement.  

Why Should I Measure? 

A common mantra in quality control is that “you cannot control what you do not measure.” The best 

producers do not haul out their test equipment only when things fail – they monitor the condition of their 

process often, and make corrections as they are warranted. 

Here are a few reasons to measure the performance of your UV system: 

• To avoid costly downtime, rework and scrap due to diminished UV output 

• As part of an ISO or QS- SPC or other quality assurance program  

• To optimize your curing process and increase productivity and profits 

• To communicate more clearly with partners, suppliers and customers 

• For suppliers- to document a curing process so it can be replicated in the field 

What Should I Measure? 

When you bake a cake, you care about two variables: oven temperature and cooking time.  

When you cure UV materials you are concerned about three factors:  wavelength(s) of the UV, power (or 

irradiance), and energy (or energy density). Each of these parameters can alter the degree of cure at the 

surface, at the substrate, or throughout the material. 

Wavelength:  The output of a UV source can vary based on the source type and whether is it a UV 

broadband or UV LED source.  

UV Broadband Sources: These are mercury based and characterized by a “broad” (wide) output across 

the UV spectrum. Typical bulb types include mercury (sometimes called H), mercury-iron (D) or mercury-

gallium (V).  The actual output can vary from supplier to supplier and also how the output is displayed.   

Two different examples are shown below.  
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Top:  Mercury, Mercury-Iron and Mercury-Gallium Bulbs 
Bottom: Mercury (H) Courtesy of Heraeus Noble Light 

 

 

 

 

 

 

 

 

 

 

EIT UVA, UVB, UVC & UVV Response bands 
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The EIT 2.0 UVA, UVB, UVC & UVV Instrument response bands have been designed to support the UV 

output from broadband sources.  

UV LED Sources: The output from an UV LED source is determined by the source manufacturer. UV LED 

sources are usually specified by the center wavelength (CWL), in nanometers (nm). The CWL can vary +/- 

5nm and the typical energy distribution at the 50% power point is 20-25 nm wide.  Compared to a 

broadband source, an UV LED is fairly monochromatic.  

 

 

The distribution of energy across these bands depends on the design and operation of the LED source.  UV 

LEDs are also supplied with output specified at particular wavelengths.  Unintended changes in energy 

within various bandwidths can adversely affect properties such as surface or “through-cure”. 

EIT 2.0 has designed and patented a Total Measured Optic Response for LED wavelengths. Designated “L-

Bands”, the optic response and band is identified by the letter “L” and the nanometer range (“395”) in 

which it was designed to measure.   
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The L395 radiometer response is shown below.   

 

UV Measurement Terminology 

Power/Irradiance:  Irradiance is the “brightness” of the light source.  Irradiance generally falls off with 

distance as you move away from the UV source and/or as the light source output diminishes (reduced 

power) for any reason. If you move twice as far away from a broadband source, you would expect the 

irradiance to fall off by the square (22) of the distance change and be approximately ¼ (25%)  of the original 

value 

Users will need to test how their LED system, made of many ‘point’ sources, responds as the distance and 

applied power change.    

Irradiance is measured in Watts (W/cm2) or milliWatts (mW/cm2) per square centimeter. Although 

different in meaning from a technical definition, irradiance is sometimes also called intensity.  

Energy/Energy Density:  Irradiance alone is not a sufficient measure of the UV cure process, since proper 

curing requires a certain amount of exposure time.  Energy density is a measure of how much power was 

received over a length of time. If you chart irradiance on a vertical axis against time on the horizontal axis, 

energy density is the area under the curve.  Although different in meaning from a technical definition, 

Energy Density is sometimes also called “dose”. Be sure to communicate in the same language and terms.     

 

The bandwidth response of EIT’s LEDCure® radiometer for the L395 band measurement. 
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To calculate the area under the curve, your EIT 2.0 radiometer takes frequent irradiance readings, and 

then calculates then integrates this area. Energy is measured in Joules (J/cm2) or milliJoules (mJ/cm2) per 

square centimeter. 

 

   

 

 

 

 

 

 

 

 

 

Instrument Sample Rate: The irradiance value reported by the instrument can vary based on the effective 

sample rate of the instrument and the speed at which the data was collected.   The faster the sample rate, 

the more accurate the instrument is able to capture the peak irradiance, especially at faster speeds. 

The effective sample rate is based on the Data (not Optical) Filter Bandwidth.  EIT 2.0 instruments use 

different bandwidths for the data filters. From a technical standpoint we use 7, 35 and 700 Hz data filters 

in the Profiler units and filters from 7-700 Hz in the PowerMAP II.  

From a practical stand point we refer to the data filtering as an effective sample rate. The three data filters 
in the Profiler units equate to the following sample rates:  

• 7 Hz : Effective sample rate of 25 samples/second, referred to as Smooth On 

• 35 Hz: Effective sample rate of 128 samples/second, referred to as Smooth Profiler 

• 700 Hz: Effective sample rate of 2048 samples/second, referred to as Smooth Off 
 
The EIT 2.0 PowerMAP II has a user adjustable sample rate from approximately 128-2048 samples per 

second.  

The PowerMAP II exact sample rate is shown in the Sample Information and Notes Box in PowerView III.  
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Energy density is the total amount of energy exposure over time.  It is the mathematical calculation of the 

area under the irradiance curve.  The instrument calculates energy density by adding many irradiance 

samples together. The numerical irradiance reported is the peak irradiance value recorded by the 

instrument   

Peak Irradiance 
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The EIT 2.0 Profiler (LEDCure Profiler, Power Puck II Profiler and UviCure Plus II Profiler) instruments over 

sample. The effective sample rate of the data collected and shown on the display of these instruments is 

user adjustable between Smooth On (25 Samples/Second), Smooth Profiler (128 Samples/Second) or 

Smooth Off (2048 Samples/Second).  The irradiance profile (Watts/cm2 as function of time) that is 

calculated by PowerView III for the Profiler instruments is fixed at 128 samples per second. Matching 

between the instrument display and PowerView III calculated values is achieved when the Profiler 

instrument is set to Smooth Profiler.  

Where Should I Measure? 

The EIT 2.0 PowerMAP II and Profiler instruments are designed to be self-contained, compact instruments 

that can be placed in the UV process environment.   

The optical window on the radiometer should be positioned so that it faces the UV source in the same 

location and orientation as production parts in order to provide the most representative measurement of 

irradiance at the part surface.   

Your EIT 2.0 radiometer is a sensitive electronic device and should not be exposed to long, high UV 

intensity runs with extremely high temperatures. An over temperature alarm will sound if the internal 

temperature of the device goes over 65oC.  Modify your data collection procedures to avoid damaging the 

instrument if the alarm sounds.   

If you elect to use the thermocouple on the PowerMAP II, we suggest securing it to the body of the 

PowerMAP II or the substrate/coating.  The thermocouple should not be left to ‘flap around’ freely if you 

need temperature measurements.  

The display window on the Profiler instruments should not be exposed UV. If needed, cover it during the 

collection of data.  

 

 

If your instrument is too hot to touch, it is probably too hot to take a reading.  

How Often Should I Measure?  

Regular measurement will help you detect problems before they affect your process.  You should establish 

a regimen that fits your production schedule.  The frequency of measurement is a function of 

understanding your system, process/process window and product.  Some customers, especially in the 

medical field, measure each lot of product produced while others will measure the UV once per 

production shift or even once per day.  

You should measure your process each time you make a significant alteration to your curing system, such 

as lamp changes, quartz window cleaning, lamp repositioning or line speed changes. 
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EIT 2.0 also manufactures a number of products that provide continuous measurement of UV irradiance 

for those customers who wish to constantly monitor UV output in real-time.  These devices do very good 

job or tracking changes and when used in combination with an EIT 2.0 PowerMAP II or Profiler instrument.  

 

Using both approaches provides a powerful combination for tracking real time changes and also having 

absolute values. Visit the EIT 2.0 website https://www.eit20.com/products/uv-measurement-products-

and-software/online-monitoring/ for more information about online monitoring products. 

 

Where Can I Get More Information on UV/UV LED Measurement? 
There are a number of helpful publications and technical papers on UV/UV LED measurement and process 

control posted on our website:  https://www.eit20.com/products/technical-papers-presentations/ .  

EIT 2.0 frequently presents educational talks and seminars at industry & trade show events.  

 

We also have a knowledgeable, trained group of sales representatives and distributors worldwide who 

can offer assistance and advice.  To locate a representative in your region visit:  

https://www.eit20.com/products/representatives-and-distributors/  

 

Care & Cleaning of your Measurement Device 
EIT 2.0 radiometers are used to design, measure and control industrial UV applications in a wide variety 

of locations. The environmental conditions that our instruments are exposed to vary from pristine 

(medical clean room) to challenging (wood manufacturing facility). Careful cleaning of the outer optics 

using the guidelines described will help your EIT 2.0 instrument perform as designed between service 

intervals at EIT 2.0. 

The guidelines are general and specific questions should be directed to EIT 2.0 (uv@eit20.com). 

 

Instruments that stop functioning when accidently dropped, get stuck in equipment or wind up covered 

or immersed with the product being cured need to come back to EIT 2.0 for further evaluation using a 

Service Request Form found under Instrument Support. (https://www.eit20.com/products/instrument-

care-service-ordering/instrument-service/ ) 

 

A detailed set of instructions for cleaning the optical window of your radiometer is provided in Appendix 
E of this manual. Additional details can be found on the EIT 2.0 web site at 
https://www.eit20.com/products/instrument-care-service-ordering/instrument-care/ including 
information about how to purchase pre-packaged EIT 2.0 Instrument Wipes specifically designed for 
maintaining your radiometer. 
 

https://www.eit20.com/products/uv-measurement-products-and-software/online-monitoring/
https://www.eit20.com/products/uv-measurement-products-and-software/online-monitoring/
https://www.eit20.com/products/technical-papers-presentations/
https://www.eit20.com/products/representatives-and-distributors/
mailto:uv@eit20.com
https://www.eit20.com/products/instrument-care-service-ordering/instrument-service/
https://www.eit20.com/products/instrument-care-service-ordering/instrument-service/
https://www.eit20.com/products/instrument-care-service-ordering/instrument-care/
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2. Collecting Data / Instrument Overview 
 

Do I Have the Proper Instrument? 

EIT 2.0 PowerView Software® III (Version 3.0 and higher) is compatible with the PowerMAP II, LEDCure™ 

Profiler, Power Puck II Profiler and UviCure Plus II Profiler. Profiler “enabled” Puck style units can be 

identified on the top line of the display.    

 

LEDCure Profiler units can also be identified by the label on the face of the unit.  

 

PowerView III/PowerView II software will not work with Standard (i.e., Non-Profiler) Puck units. Please 

contact EIT 2.0 to see if a Standard LEDCure, Power Puck II or UviCure Plus II can be upgraded to Profiler 

version of the unit. The unit cannot be upgraded in the field, and must be done at EIT 2.0.  

 

 

 

 

 

 

 

 

 

SOFTWARE NOTES 

PowerView III will download information from the PowerMAP II and all Profiler enabled Pucks.  
PowerView III supports the temperature measurement and the adjustable sample in PowerMAP II. 
Changes were also made to simplify the operation of PowerView III compared with previous 
versions of PowerView II.  

• The file format (*.tdms) is the same file format used in PowerView II.   

• Files collected with PowerView II can also be opened with PowerView III.   

• PowerView III will not support communication with the original, legacy version of PowerMAP   

• The PowerView® Software II (version 2.0 or higher) can be used to convert data (*.eit) files 

collected with the EIT UV PowerMAP or UV Map Plus instruments to (*.tdms) files 

• These files can then be viewed with Powerview II or PowerView III.   
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Basic Instrument Layout & Controls: Puck Style Profiler Units 

The basic layout and controls for the EIT 2.0 LEDCure, Power Puck II/UviCure Plus II Profiler devices are 

similar. The layout for a LEDCure is shown below. The Power Puck II/UviCure Plus II layout and controls 

are similar. 

 

Operation of Puck Series Instruments  

Turning On the Radiometer 
Press and Hold the ON / OFF button until the display illuminates. The display will briefly display the 
Radiometer Model Name, Serial Number, Software Version, Calibration Date, Range, and Wavelength  
Band(s) installed. The display will then enter the default mode and display the data from the last run 
before the unit was turned off. 
 
Turning OFF the Radiometer 
Press and Hold the ON / OFF button. A tone will sound. When tone stops, release the button. The unit 
turns off. 
 
Entering the RUN MODE  
A short press of the “RUN” button clears the memory and puts the unit in the “RUN” mode. The display 
shows “RUNNING” after shortly displaying the internal temperature of the unit. Confirm that the unit 
displays “RUNNING” before initiating a reading. 
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Place the radiometer on the belt or object with the optic window looking toward the UV source. The 
display and buttons will be facing away from the UV source. When the radiometer exits the curing 
chamber, the display will still be flashing “RUNNING”. 

 

CAUTION: Exposing the display to high UV radiation will damage the display. 

Exiting the RUN MODE 
A short press of the “STOP” button (Soft button display bar indicates “STOP” next to the “ON / OFF” 
button) will exit the “RUN” mode. The display will have the new UV values.  
 

Replacing the Batteries in EIT 2.0 Puck-style Instruments 
 

The UV Power Puck II, UVICURE Plus II and LEDCure utilize user replaceable AAA alkaline cells. When 
replacing these batteries, the radiometer must be turned OFF. To replace the batteries: 

1. Loosen the screw on the battery door and remove the door. 

2. Remove the old batteries. 

3. Install two new AAA size alkaline cells, observing polarity. As shown in the figure below, both cells 
are installed in the same direction. The proper direction is indicated on the PCB and on the housing 
inside the battery compartment. The unit is designed so it will not operate with reversed cells. 

4. Replace the door and the screw. 

 
 
 

 

 

 

 

 

Expected battery lifetime is 20 hours of operation. The Puck instrument features a Low Battery *LB 

indicator. If a low battery indication occurs during a data collection run, the readings are still valid.  The 

low battery indicator is designed to illuminate early enough so that your data remains valid.  Under severe 

low battery conditions, the unit does not operate.  Therefore, confirm that the unit flashes “RUNNING” 

before initiating a reading. 

 

 

 

Battery orientation in a Puck style radiometer 
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Basic Instrument Layout & Controls: PowerMAP II Units 

The basic layout and controls for the PowerMAP II are shown below: 
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PowerMAP II Button Functions  

The PowerMAP II button is used to toggle the instrument 

between four different modes:  Standby, Data Collection Mode, 

Pause and Off  
 

Push and Hold (Longer than 1 Second) 
 

1. Turns unit on from off mode. Goes from No LED to Red 
Flashing LED 
2. Turns Unit off from Red Flashing Mode  

 
Quick Short Push (Less than 0.25 seconds) 
 

1. Allows you to switch from Flashing Red (Standby Mode) to 
Flashing Green Data Collection Mode.  
 

2. The PowerMAP II deletes previous files when the unit 
switches to Flashing Green Mode from Standby Mode 
 

3. Switch from Green Active Data Collection Mode to Yellow 
Pause Mode  
 

4. The Power MAP II will allow the user to pause the unit up to 
8 times to collect multiple files from different lines around a 
facility  
 

5. Each push of the Pause function causes the PowerView III 
software to decrement the file into separate data files when 
transferred to the computer.  
 

Long Push (Approximately 0.5 Seconds)  
 

1. Move from Yellow or Green to Red 

 

Note: You may also elect to do a Push and Hold when you are 

done collecting data to go from the Yellow or Green Modes to 

unit off Mode. 
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PowerMAP II Batteries and Charging   

The PowerMAP II utilizes a long-lifetime, rechargeable battery.  This battery is not field-replaceable, and 

is charged through the mini-USB port on the device.  A mini-USB to USB cable is provided with the unit 

along with an AC power Smart Charger. The Smart Charger has universal plug adaptors.  

The Smart charger provided with unit recharges in fast mode (+/- 90 minutes).  Before charging, it is 

recommended to turn set the unit to Off Mode. 

The unit may also be charged via a USB port (i.e. computer). The charge time when using a USB port varies 

based on the USB port performance.  

Battery life of 100 minutes typical on a full charge.     

The battery charge status is shown in the Sample Information and Notes panel in the PowerView  Software 

III. A full charge will show as up to 1.5 Volts. In the example below the Battery Voltage was 1.43 Volts.  
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3. Installing the Software 
 

 

Basic Software Installation Procedure  

The EIT 2.0 PowerView® Software III Version 3.0 or greater is digitally signed, designed to run in a Microsoft 

Windows environment and can be installed on Windows 7 and 10 platforms. The system can also be 

installed on Apple computers that provide a dual boot operating system by running the program using a 

compatible Windows operating system. 

If you are installing the software from a factory supplied USB Stick, and double click the PowerViewIII 

executable (*.exe) file.  

If downloading the software from the EIT 2.0 website, first download and save the PowerViewIII 

executable (*.exe) and then double-click on it to start the installation. Do not try to install the software 

directly from the EIT 2.0 website.   

As part of the installation procedure, the software will also install needed National Instruments LabVIEW 

files. The installation utility will guide you through the PowerView Software® III installation process.  

 

 

Select the *.exe file to begin the PowerView Software III installation 

PowerView III is a 32 bit program and will run on 32 or 64 bit computers. Users on certain secure 

local area networks may need to consult with their System Administrator for assistance installing 

the software. 
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Step 1 of the process. Getting ready for download. 

Step 2 of the process. Set the location for the PowerView software or use 

the default setting. 
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Step 3. Accept the installation license terms and select “Next>>” to continue  

Select Next>> to accept the software changes and additions 
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Do not interrupt installation process until it is complete.  

Finally, you must restart your computer to complete the installation process. 
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The software has been optimized for a display resolution of 1280 x 800. 

You may also want to install a Shortcut to the PowerView program on computers desktop following the 

procedures of your Windows operating system version. 

Demonstration (Demo) Data Files 

PowerView Software III contains demonstration or “Demo” data files, some of which are used in this 

manual to illustrate how to use your profiler.  These files can be accessed by clicking on the Demo Button 

in the upper right of the screen.  The “Back to Data Folder” button points the PowerView III software back 

to the location where you have placed collected data files.  

 

The “path” to your files can be specified under the configure tab on the tool bar. This is described in 

Section 5 of this manual in more detail. 

 
There are 14 demonstration data files: 

• 4 UV LED files collected with an L-395 LEDCure Profiler  

• 6 microwave source files collected using a UV PowerMAP II  

• 4 arc lamp systems:  2 of which with a UV PowerMAP II, 2 Power Puck II Profiler  

• The instrument used is displayed in the System Information panel at the bottom of the screen  

• A thumbnail of each of these files is shown in Appendix E 
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 You may open any of the 14 supplied LED, microwave or arc lamp demo files 
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4. Starting the PowerView Software® III Application 
 

Once installed, the EIT 2.0 PowerView Software® III application can be started by clicking on the 

PowerView III icon the Programs menu of your Start Button. From the Start Button you can select EIT → 

PowerView III →  PowerView III to open the application.  You may also create a shortcut.  

 

 

 

 

 

 

 

Either action should launch the PowerView Software® III application.  It may take a minute or two to load 

the software package during which time you should see the following welcome screen:   

   

 

 

 

The PowerView III from a shortcut Desktop Icon 
Accessing PowerView III from the START Menu  

The PowerView III Welcome Screen 
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Once the software has fully loaded, the main EIT 2.0 PowerView Software® III screen should appear. You 

may need to adjust your monitor’s display settings so that you can see the entire screen on your monitor. 

Notice that there are two “tabs” and the default “Graph by File” view is selected.  

 

 

Configuring Your Profiler Device for PowerView Software® III 

As described in the Basics of UV Measurement, calculating energy density accomplished by 

mathematically summing many irradiance samples together (see Chapter 1).  The rate at which these 

samples are collected can result in slightly different values.  

EIT 2.0 “Puck Style” instruments have 3 Smooth settings: “Smooth On”/ “Smooth Off”/ “Smooth Profiler”. 

Adjusting your instrument to “PROFILER” mode, sets the effective sample rate of the instrument to 128 

samples/second. PowerView Software® III calculates the irradiance, irradiance profile and energy density 

readings from the transferred data. This allows the values calculated by your radiometer (and shown on 

the instrument display) to closely match the values calculated by PowerView Software® III.  

 

The default PowerView III screen showing the Graph by File view 
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To Change Instrument Settings: 

1. Enter the Setup Mode, using the soft button to the left of the display 
2. Press and hold for 0.5 second, then release. The Setup screen will display the current settings.  
3. Selected lines and saved settings will appear preceded with an *asterisk. 

4. To change selections between SMOOTH ON, SMOOTH OFF and SMOOTH PROFILER, use the down   

and right → arrow buttons located under the arrows to scroll in the indicated direction.  
5. To change the current selection, first select the line, then the setting on each line.  
6. Press the SAVE button to save the setting.  
7. An *asterisk will appear next to the setting to indicate it has been saved.  
8. When the changes are completed, press the EXIT button to return to the default mode.  
 

Note: The selected “Smooth” mode the user has set in the instrument will be displayed by the PowerView 

Software III program.  Note that the “Actual Sample Rate” and the “Date & Time” that the information 

was transferred to the computer are also displayed in the Sample Information & Notes box.   

 

 

 

 

 

For matching between PowerView 

Software® III and the instrument 

display select SMOOTH PROFILER in 

SETUP Mode. 
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Configuring your PowerMAP II Device using PowerView Software III    

The PowerMAP II has user adjustable configurations. In order to make changes to the default parameters, 

the PowerMAP II must be connected to your computer via the USB cable and powered on in the Standby 

(Red LED) Mode.  Once in this mode you may select the Change PowerMAP II Parameter tab below the 

main toolbar: 

 

You may set desired sample rate from 128-2048 Hz.  

The PowerMAP II is capable of collecting over 60 minutes of data collection even at the fastest effective 

sample rate of 2048 Hz.  There is more resolution at faster sample rates but the tradeoff is longer 

download times and larger data files.   

The Pause Feature may be enabled/disabled, as desired, by selecting the target value and clicking on the 

appropriate ‘Set’ button to update a device. The example below shows a device with the Pause Feature 

as disabled. 
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You may also select the temperature parameter you would like the software to display (Board, 

Thermocouple, or Auto), by selecting Configure → Select Temperature Channel from the main toolbar. 

 

 

 

This will open the Select Temperature Channel radio button dialog box: 

 

Selecting Auto will display the Thermocouple Temperature when it is connected or the internal board 

temperature of the PowerMAP II printed circuit board when the Thermocouple is not connected.  
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Right Y-Axis Thermocouple Scale °C and 
Temperature Profile 

Left Y-Axis: UV Irradiance Scale Watt/cm2 

 

 

 

 

 

 

The temperature profile is often much higher than the UV profile.  It is sometimes best to turn off the 

Thermocouple (TC), scale the UV irradiance profile and then turn the temperature profile (TC) back on.  

 

X-Axis Time Irradiance Profile 
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5. Importing Data from an EIT 2.0 Radiometer 

 

Data collected by Profiler radiometer can be downloaded from the device and saved on your computer as 

a data file (with a .tdms extension). This data can then be viewed and analyzed using the EIT 2.0 

PowerView Software® III application. The PowerView III .tdms file may also be analyzed with Microsoft 

Excel® by using the TDM ADD-IN available for Excel.  

To Download Data from a Profiler Radiometer:  

1. Connect the device to the computer using the factory supplied USB to mini-USB connector.  (Note: 

The USB-mini USB cable is a standard cable that is widely available if your cable is lost, misplaced or 

damaged.  The cable can also be purchased from EIT 2.0 if desired.) 

 

 

 

 

 

 

 

2. Turn on the device by depressing the Power on/off button  

 

Connecting a Radiometer via the radiometer’s mini-USB connector 

Default PowerView II Graph by File Screen 

Warning: The PowerMAP II or Profiler Instruments are NOT 
designed to collect data while they are connected to a computer via the USB cable. 
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3.  On the EIT 2.0 PowerView Software® III toolbar, select:   Device → Get Data From Device  

 

 

 

 

 

 

As you will see with PowerView III, there are often mutiple ways to perform common tasks.  In additon to 

the toolbar, try right clicking throughout the software with your mouse.   

 

 

 

 

 

 

To transfer data from your radiometer to the PowerView Software® III program, you can also point your 

mouse to the Device Read Data From Device tab at the top center of the screen. This will activate a dialog 

box which contains the Read Instruemnt option 

 

Transfer data by selecting → Read Data From Device is located at the top-center of the screen. 

If a device is properly connected, a dialog box that allows you to select the location to download the data 

will open.  If no device is recognized an error message will appear.  Please assure the device is properly 

connected and powered on. 

 

Transfer data by selecting → Device → Get Data From Device 

Many PowerView Software® III features can be 

accessed easily by right-clicking when your mouse 

is properly positioned on the screen. 
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4.  You should observe the “Downloading Data” dialog box (though it may flash by too quickly to read) 

while data is being imported from your device into the EIT 2.0 PowerView Software® III application. 

 

 

 

If no device is connected or the unit is off, you will receive a message 

Download Data which shows progress bar and counter, in percent completed 

If the device is busy, you will receive a message 
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Reading data from your radiometer does not remove any data from the device, but merely transfers the 

data into the software for analysis.  Your original data is preserved in the instrument until you take a new 

reading by entering the RUN mode. 

Note:  The file structure and storage location for ‘behind the scenes’ files varies significantly for different 

versions of Windows.  The Driver which allows communication between the instrument and Windows is 

digitally signed. If the PowerView Software® III fails to recognize your EIT 2.0 radiometer, or succesfully 

transfer data contact your internal IT resources or EIT 2.0.  

 

Creating Data File Names 

Once the file is downloaded, you will be prompted to save the file. PowerView III will prompt you with a 

“YYYYMMDD_”  format. You may elect to use this format and further name the file or save the files in any 

manner that meets your needs.  You may use the factory selected default location, or create a new file 

folder and location. 

 
 

Each file actually consists of two files: A TDMS File which contains the data and a TDMS_INDEX File which 

contains a shortcut to the file.   

 

 

Default file format structure showing “YYYYMMDD_” format plus user added name  
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When the PowerMAP II Pause feature is utilized, the files are automatically broken down into individual 
files as shown below with the suffix “run_1” through and up to “run_8”   

  

 

PowerView® III files may be shared and exchanged electronically (e.g., via Email, USB Stick).  

Organizing your Data Files 

All data files look the same to the PowerView Software® III.  The file selected as “the sample”, is always 
compared to the file selected as “the reference”. The data points by themselves cannot tell you anything 
about which line, lamp, or for what product, the data was collected, or who collected it.  So if these details 
are important to track, proper note taking and data organization is imperative.  
 
PowerView Software® III provides several tools to help you add notes, and organize your data files.  The 
note taking capabilities will be described in Chapter 7, but you should first decide how you want to 
organize your files. Common choices include by:  

• UV system type (LED, arc, microwave) 

• Lamp type (395 nm, 365 nm, broad band mercury, mercury-iron, etc.)  

• System or production line 

• Date (Default File name starts with Date) 

• Customer, R&D parameter such as the formulation, power supply, substrate type, etc.  
 

 
 
 
 
 
 
 
 
 
 

Example of standard data transferred to the computer from the instrument  

 

Paused file format structure in directory   
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To change where you store your files:  From the Toolbar select Configure → Set Path  
 
 

 
 
 
 
This opens the Configure Paths window which will allow you to specify a new folder name, or location for 
your data files, and sample and reference shortcuts. You may choose locations that are appropriate to 
your work environment and naming conventions by clicking the folder icons.  
 
 

 
 

 

 

 

 

 

 

 

 

 

Launch the Configure Paths window from the Toolbar 

Change folder names and locations for your files from the Configure Paths window  
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6. Quick Overview – Two Views of Your Data 
The Two Types of PowerView Software® III Screens 

Once the software has loaded, the main EIT 2.0 PowerView Software® III screen will appear. You may need 

to adjust your monitor’s display settings so that you can see the entire screen on your monitor without 

scrolling.  (Note: The PowerView Software® III has been optimized for a 16:9 aspect ratio to eliminate the 

need to scroll during use, and this setting should be selected when possible.) 

When the EIT 2.0 PowerView Software® III loads, it defaults to the Graph by File screen.  This is one of 

two basic ways to view data in PowerView Software® III.  The other choice is to Table by File. Simply select 

the Tab for the view you wish to use.  These two choices present the same radiometric data in different 

formats.  They make it more convenient to perform different types of data analysis.    

 

 

 

 

 

 

We begin by introducing the basic function and motivation for each of the two views before describing 

how to navigate and manipulate these views.   

1. The Graph by File Tab 

The Graph by File view is ideal for visually comparing two different data files.  One of these files is referred 

to as a SAMPLE file, and the other file is described as the REFERENCE file. 

There is nothing physical that differentiates a sample file from a reference file other than referring to 

them by these names.  It is common practice however to compare fresh data samples to a benchmark, or 

reference set of data that might have been collected when new lamps were installed and the line was 

operating perfectly. We suggest that you give files that are ideal ‘golden’ files a name they can be easily 

identified that distinguishes them.  

The screen below shows a typical plot in the Graph by File view. Drop down menus in the upper right 

corner allow you to select a sample file and reference file for comparison. (Although there is nothing that 

requires you to actually plot two graphs. You could, and often will want to display only a single plot.)  

Below is a graph of the EIT 2.0 LED Sample Data file provided as an example.  

 

Data may be viewed in Graph by File or Table by File format Band.  
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When using a Profiler Instrument (in this case LEDCure Profiler) to view summary information you must 

select a Band.  Here, the L395 band has been selected. The numerical calculations performed in this 

Summary Section compare the radiometer data for the sample file to the reference file. Since we have 

not yet selected a Reference File, only the data for our Sample is shown. 

Now, select a Reference File.  In the Graph below we have selected the EIT 2.0 LED as the Reference Data 

file. 

 

 

Opening the reference file first, before the sample file, is a good practice since the software will 

automatically scale the graph according to the reference data which is usually equal to, or greater than 

subsequent samples. However, if you open data files and the scaling is improper you can always select 

the Zoom All button to rescale the graph. 

 

 

 

The EIT LED Sample Data file graph. Note: Remember to select a Band to get Summary data.  
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2. The Table by File Tab 

Table by File is a numerical view of the same data used to produce the Graph by File plots.  Like Graph by 

File, Table by File is used to compare various aspects of two data files, usually a sample and a reference 

file.  For example by selecting the Table by File tab using the example above you see: 

 

 

 

The same LED Sample and Reference files in Table by File view  

Comparing a reference file (dotted lines) and sample file (solid line) for an LED system 
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In Table by File view shown  later in this section, numerical data for each file is presented in adjacent 

columns.  A third column, labelled  “Difference” compares the data in the Sample and Reference file 

columns and, by convention, computes the absolute difference between the sample and the reference 

file (i.e. Reference – Sample = Difference) and also the percentage difference between the Sample and 

Reference.    

The organization of the rows of the Table by File view is determined by  the Table View dropdown menu 

which can be set to either Parameter view or Bandwidth view. 

 

 

A) Parameter View: 

When Parameter view is selected, the rows of the table contain the UV parameters:  Power (grouped by 

UV band) and Energy (grouped by UV band).  Each parameter is presented in both absolute terms (e.g. 

mw/cm2 and mJ/cm2) and as Power % and Energy % which reports the percentage difference between 

the Sample and the Reference (grouped again by UV band). 

Note:  If the cursors are turned OFF, (as will be discussed in the Advanced User Tools chapter), the 

maximum values for each bandwidth are displayed and used to compute the differences.  If the cursors 

are turned ON, the values displayed will correspond to the sample and reference cursor locations. The 

status of the cursors is indicated on the cursor row near the bottom of the table. 

As an example, compare the demonstration file for the H bulb run_1 (loaded as the sample file) and the 

H bulb run_2 loaded as the reference file. 

 

 

The Table View dropdown menu  
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In Parameter view we obtain a table where rows are grouped by irradiance, and then energy density: 

 

If the dropdown Table View menu is changed to Bandwidth view, our data is grouped by “EIT 2.0 band”: 

 

In Bandwidth view, the same data is arranged differently.  In this view, the Sample, Reference and 

Difference columns remain the same, but the rows are organized by grouping the parameters (Power 

level, Power%, Energy level and Energy %) by Bandwidth as shown below.  The influence of the cursor 

status on the numerical values displayed is the same as it is in Parameter view. 
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Remember that with cursors turned off (discussed in Chapter 8) the Energy Density reported is the total 

energy density for ALL UV sources collected in the Sample), but the peak irradiance is the intensity of the 

highest UV source observed.  

When a Reference File is selected (such as the Reference Data file used in this example), the Table by File 

chart allows you to easily compare the Sample and Reference data files. 

 

 

In this example, the Sample Data has less Power than the Reference Data for UVC and UVV wavelengths 

(-1.7% and -0.5 respectively), but more Power for UVA and UVV (+2.8% and +0.4% respectively), but more 

Energy Density at all wavelengths.  . 

The Graph by File and Table by File views are motivated by similar questions such as “how do I compare 

two radiometers and examine the differences between the two?”  The Graph by File and Table by File 

views are the most common choice. 

Table by File using Bandwidth View   
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7. Basic Navigation and Tools 
 

The EIT 2.0 PowerView Software® III application has a number of powerful tools for analyzing UV 

radiometer data.  In this chapter, we begin by describing how to open your data, select which bandwidths 

to display, and how to navigate the graphs using the ZOOM control options. We also introduce the 

Summary feature obtaining numerical values and comparisons from your datasets. 

 

Opening Your Data Files for Analysis 

Once data has been downloaded from an EIT 2.0 Profiler, these files are accessible within the PowerView 

Software® III application from the Sample File and Reference File pull down menus that are located near 

the upper right corner of the screen.  

It is a common practice to create a “reference file”, made when the line is operating under optimum 

conditions. This reference file can be used as a benchmark for comparing subsequent samples to verify 

that the process is operating properly.  It is a good idea to name the reference file so that it can be easily 

identified and distinguished from sample data files to avoid confusion. 

For example, to open the reference file, click on the dropdown menu and select the desired reference file 

by name. In this example we will compare the two LED files (two passes at different power levels as the 

Sample, and two passes at different speeds, as shown below:  

  

 

 

 

 

To begin, access data files via the dropdown menus 
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 As noted in the previous section, a good practice is to open the Reference file before the Sample file, 

since the software will automatically scale the graph according to the reference data - which is usually 

equal to, or greater than subsequent samples. 

After selecting these files, you should see the following graph: 

 

 

 

 

 

 

 

 

Graph by File view of the Sample and Reference files 
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Note that the software automatically displays the instrument’s display values in the Information & Notes 

panes for both the sample and reference files.  Along with the recorded data, the software also displays 

the devices Serial Number, internal temperature, and other device specific parameters. 

 

Editing Sample Information & Notes 

Since accurate record keeping and organizing data is of such great importance, we introduce the 

Information & Notes editor feature of the PowerView Software® III early in this manual.  Some additional 

editing tools for note taking are presented in Chapter 11. Device Information and Notes may be displayed 

as combined in one pane or separated into two panes. Device Information may be displayed as 

compressed into few rows or expanded with one piece of information per row. 

The Information & Notes can be edited and annotated by a simple procedure:  

1. Right Click while the cursor is positioned within the Information & Notes pane. 

 

 

2. Click on the Edit Notes button that appears. This will open an editing window that permits free form 

entry of additional information: 

 

 

Radiometer data is visible in the Information & Notes panes  

Right click in the pane to launch the Edit Notes button  
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3.  After editing, click SAVE  

The editing window will be closed, and the Sample Information & Notes will be updated. 

  

 

 

 

 

Selecting which Bandwidths to Display 

The PowerView III software allows you to analyze UV output data from single band (UviCure Plus II Profiler 

/ LEDCure Profiler) or multiband (PowerMAP II / Power Puck II Profiler) instruments. You can view spectral 

output from mercury based sources in the UVA, UVB, UVC or UVV bands, or select which LED band (e.g. 

L-395 or L-365) depending on your radiometer.  This makes it easier to focus on wavelength specific 

features of the data.   

The Information & Notes editor screen  

Example of additional notes and comments added 
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Let’s look at an example using data (from a mercury H-bulb) collected using a four-band PowerMAP II 

radiometer. Load the Sample file shown below:  

 

This produces the following Graph: 

 

By default, the software shows data for all of the available channels. 

 

Note:  For PowerMAP II TC= ThermoCouple or board level temperature based on  
what temperature choice was selected during set up 

 

You may focus on a particular channel by selecting the band of interest. For example, the graph below is 

the result of selecting only the UVA channel. 
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Viewing Summary Data 

Though the EIT 2.0 PowerView Software® III provides a number of graphical analysis tools, it is also useful 

for analyzing hard numerical data using Table by File view. 

 Numeric data is also summarized in the Graph by File view.  The Summary data window located in the 

lower right of the screen is useful in comparing values for the peak irradiance (Power) and energy density 

(Energy) between reference and sample readings.   

The values displayed in the Summary data pane depend upon whether the cursors feature has been 

turned on or off. For more information about using cursors, see Chapter 8 below. 

With the CURSORS button toggled to the off position, (the default on software startup) the summary data 

will display the maximum value for the selected Bandwidth.  With CURSORS turned ON, (indicated by a 

green color) the data displayed will be the Power and Energy values of the selected bandwidth at the 

current cursor location.  

 

 

 

In order to obtain proper measurement data in the summary section, the radio button must be changed 

from the default All Channel setting to Single Channel and a single channel is then selected from the drop 

down menu. For example (e.g. UVA vs. UVC in this example) 

Only selected bands are plotted in the resulting graph 
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 Using the Zoom Controls 

The Zoom tool (identified by a magnifying glass icon) provides several aids to navigating graphs.   

 

Clicking on the Zoom (magnifying glass) icon will reveal several Zoom options.   

 

 

The Zoom Control options perform the following tasks:  

 This tool zooms on a user-selected rectangular area. Click on the tool to select it, and then position 

the cursor so that it is located at one corner of the desired rectangular area. Press the left mouse control 

button to select that corner of the desired area. Then, while continuing to depress the left mouse button, 

drag the mouse to the opposite diagonal corner of the desired rectangle. Releasing the left mouse button 

will anchor the entire rectangle, and the software will zoom on the selected area. 

 This tool zooms on a user-selected portion of the graph time line (x-axis). Click on the tool to select 

it, and then position the cursor so that it is located at one end of the time period of interest. Press the left 

mouse control button to select one extreme of the desired range. Then, while continuing to depress the 

Several Zoom tools are available for different tasks 
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left mouse button, drag the mouse to the opposite edge of the range. Release the left mouse button to 

zoom on the selected time period of the graph. 

 This tool zooms on a user-selected portion of the graph y-axis. It is useful for magnifying portions 

of the graphs to look at Power (irradiance) detail.  Click on the tool to select it, and then position the 

cursor so that it is located at one end of the power level of interest. Press the left mouse control button 

to select one extreme of the desired range. Then, while continuing to depress the left mouse button, drag 

the mouse to the opposite edge of the range. Release the left mouse button to zoom on the selected 

irradiance portion of the graph. Note that this expands the Power axis across the entire time period of the 

graph. 

 This tool performs a Zoom Out function.  Click on the tool to select it, and then position the cursor 

on that portion of the graph you wish to Zoom Out from.  Pressing the left click button will zoom out from 

the current cursor location in both the X- and Y- direction.  Each time the button is clicked, the 

magnification will be increased.  If the mouse is moved to a new location and pressed, the graph will Zoom 

Out from the new location. 

 This tool performs a Zoom In function.  Click on the tool to select it, and then position the cursor 

on that portion of the graph you wish to Zoom In from.  Pressing the left click button will zoom in from 

the current cursor location in both the X- and Y- directions.  Each time the button is clicked, the 

magnification will be decreased.  If the mouse is moved to a new location and pressed, the graph will 

Zoom In from the new location. 

 This tool is a Zoom “undo” button. Click on this icon to restore the graph to its default zoom 

setting. This button has the same effect as the Zoom All button:                          

 This tool is a Zoom X button. Click on this icon to automatically scale the horizontal axis 

to the available data.  This action does not change the Y-axis zoom setting. 

 This tool is a Zoom Y button. Click on this icon to automatically scale the vertical axis to 

the available data.  This action does not change the X-axis zoom setting. 
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Use the Zoom All or Zoom Undo buttons if you want to quickly restore the graph settings to the default 

view.  

A slider control, located just below the graph allows the graph to be repositioned from left to right should 

portions of interest be out of range in the current display. This is especially useful when the ZOOM controls 

are used as will be described in more detail below. 

 

 

 

To Zoom on the selected area, select the Zoom tool to get the Zoom choice menu. In this example we 

choose the horizontal zoom option (though we could select from other vertical or rectangular area zoom 

choices: 

 

 

Next, Zoom Horizontally by first grabbing and dragging the left and right Zoom MARKERS near the edges 

of the peak of interest.   

 

 

 

 

Detail of the Slider Control used to reposition a Graph on the X-axis 



    7.  Basic Navigation & Tools 

P/N 93318 Rev B   •    March 2023    •    PowerView® Software III Guide   49 

 

 

Releasing the mouse button after indicating the zoom range results in a more detailed view: 
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8. Using Cursors – Numerical Analysis 
 

You can turn on the cursors by selecting the Enable Cursors radio button. 

 

 

 

 

This will activate the Sample (solid) and Reference (dashed) cursors. As you Drag either cursor to a desired 

measurement location, the irradiance value will be displayed.  Note that to compare two locations on a 

single plot, you can select the same file for the Sample and Reference. This will allow you to measure the 

Power at the location of each cursor, to compare the two, and to calculate the Energy Density between 

the two cursors. 

To move the cursors, select the Cursor handle tool: 

 

You may now click on, and move each cursor to any location on the plot you wish to measure. For 

example, we can measure the dip in the center of the lamp by locating the cursors as shown: 
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This produces the following data: 

 

 

 

Here we see the left hand (sample) cursor located at 5.7 seconds, and the second (reference) cursor at 

5.83 seconds (the Delta Time is therefore 0.13 seconds as shown).  In this example there is a 77 mW/cm2 

difference between the peak at 316.085 mw/Cm2 and the dip of 239.070 mW/cm2. 

 

Understanding the Graph Axes 

The previous section introduced the basics of displaying graphs and data.  Graphs in PowerView Software® 

III display Power on the vertical, or Y-axis, and Time along the horizontal, or X-axis. 

 

Detail of Summary data for a Reference and Sample file  



    8.  Using Cursors: Numerical Analysis 

P/N 93318 Rev B   •    March 2023    •    PowerView® Software III Guide   52 

 

 

 

Time begins at 00:00 (minutes: seconds) and corresponds to the time when data was encountered on 

time scale.  The graph above shows the data recorded by a LEDCure® Profiler traveling on a conveyor with 

two lamps. The peak of the first lamp is at approximately 16.5 seconds, and the second at approximately 

43.5 seconds. 

 

 

 

 

 

 

 

 

 

 

 

Graphs in PowerView II present data by plotting Time on the X-axis and Power on the Y-axis 
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Superimposing Graphs with the Sync Tool 

It is frequently instructive to compare two graphs by superimposing them.  This technique makes it easier 

to visually compare different features that could be associated with properties of the lamps, reflectors, or 

other components. The SYNC PLOTS button is used to overlay two points in the plot area. It does this by 

horizontally aligning the Reference and Sample cursors.  

To overlay two graphs using the EIT 2.0 PowerView Software® III application: 

1. Position each of the two cursors on corresponding parts of the curve. These two locations will be used 

to sync the graphs. For example, a cursor has been located on each of the peaks in the graph below. 

 

 

 

 

 

 

 

 

 

 

1. Click on the SYNC PLOTS Off button to turn it Green 

 

 

 

 

  

 

 

Position cursors to the points on each plot that will be superimposed 
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9. Setting Thresholds 
 

 

Why Set a Threshold? 

A threshold “sets the bar” for what UV measurements the PowerView Software® III will consider for 

display and calculations.  Readings below the threshold will be disregarded for these purposes.  

Sometimes a threshold is used to eliminate stray UV measurements inadvertently recorded by the 

instrument (due to poor system shielding for example).  Or, setting a threshold can be used if the 

instrument reports “negative numbers.”  Due to changes in conditions, and instrument variation, it Is not 

uncommon to see small negative numbers, close to zero in the data. Setting a zero threshold makes 

Energy Density calculations more realistic. 

 

How to Set a Threshold 

The EIT 2.0 PowerView Software® III uses NO THRESHOLD as its default. This means all data recorded is 

used for display and calculation.   

To set a threshold: 

1. Check the Use Threshold box in the lower right corner of the screen. 

 

 

 

 

 

2. The numerical vlaue for the threshold may be entered directly by clicking in the number display pane, 

or by incrementing/decrementing the threshold value up/down buttons. Here a (small) value of 4 mw/m2 

is entered. 

 

 

 

By default, thresholds are turned off.  
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The Effect of a Threshold 

Setting a threshold to disregard radiometer data below the designated value, will reduce the Energy 

Density (mJ/cm2) when positive Power values are ignored, and raise the Energy Density when negative 

Power values are disregarded. 

Consider the following example: 

 

 

 

 

 

 

 

 

 

 

In this example, without applying a Threshold, the peak Power is 325.695 mW/cm2 in the UV band with 

total Energy of 368.234 mJ/cm2 (between the two cursors shown). 

When a Threshold of 20.000 mW/cm2 is applied, there is no change in the Power level, but the Energy is 

reduced to 325.695. 

For purposes of illustration, we have depicted the threshold (which is not actually displayed in 

PowerView® III) by the dashed red line on the sample graph.  The effect of the Threshold control, is to 

cause all measurments below the dashed line to be eliminated from the Energy computation.  

 

 

 

An example of the effect Threshold level on Energy calculations 
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Cursor Legend 

An adjustment for the Cursor Legend is shown undeer the graph. 

 

When activated a  pop up menu  is displayed  on the right side of the screen  

 

 

Clicking on the black box to the right of the name allows you 

to highlight a cursor.  

 

 

 

Right clicking on the black box brings up a menu to allow you to 

adjust the look of the cursor  
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10. Exporting Graphs, Tables, and Data Sets 
Moving Beyond PowerView Software® III  

As powerful as the EIT 2.0 PowerView Software® III application can be, there are times you will want to 

share  graphs, data tables and even your raw data for use with other programs, perhaps for further 

analysis, reporting, or sharing with colleagues and suppliers.  The software has tools that allow you to save 

graph images and data tables and export data sets in standard formats that can be read by programs like 

Microsoft Excel®   and other statistical software.  

Sharing Graph Images  

Depending on your preference, there are two convenient methods for exporting a PowerView® III graph. 

The PowerView® III program exports the graph as an Image in a standard file format such as a JPEG graphic 

file. 

1.  Share Graph Image from the Toolbar: Select File → Export Image… 

 

2. This will launch the Export Front Panel dialog box. You have the choice to save the image as a BMP to 

the Clipboard or File  
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3. Share the Graph Image with a mouse right click. The dialog box will appear if you hold the cursor on 

the graph and right click.   

 

 

 

 

 

4.  Clicking on Export Simplified Image will being up the dialog box on the right above The file may be 

saved either to the Clipboard so it can be cut and pasted into another application, or saved to a File on 

your computer.  The File command will open Microsoft Explorer to allow you to choose a location to store 

the file by selecting  the Export Key   
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5. The Export Image on the Toolbar menu may also be used to capture the Table by File data  

 

Exporting Data 

To export data to Microsoft Excel® or other statistical software package, right-click on the graph in the 

data table in the Graph by File tab.  

 

 

 

 

 

 

 

 

 

 

This will launch an Export dialog box where you can select whether to copy data to the clipboard, or to 

export data to Excel.  Selecting Export to Excel will Open a file in Excel with the raw sample data.  

  

 

Right click on a Graph to open Export dialog box 
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EIT 2.0 provides users with access to the raw sample data collected by your radiometer.  This data allows 

advanced users to create their own graphical and numeric analysis using other software applications. 

Once in Excel®, the data can be viewed, manipulated, saved or exported in another convenient format 

(e.g. comma delimited, .csv file format).   

NOTE:  It is a good practice to always back up important data to protect against unintended loss when 

performing these data handling procedures. The entire dataset is now visible. Each bandwidth recorded 

is displayed in separate columns. Each row represents a new reading taken by the instrument.   

Within Excel you are free to use any of the tools to manipulate, display, and export data or use the data 

for calculations.  Excel® can export your data in a wide range of other formats including simple delimited 

files such as .csv formats which can be used by other applications. 

You may observe (as we have shown in this example) negative values close to zero for some readings.  

This is due to some slight variation from reading to reading and is not uncommon.  You should be aware 

of potential negative values and decide how to treat them in your own calculations. 

An Excel file with data exported from PowerView III 
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11. Advanced Analysis & Formatting Tools 
Advanced Text Editing: Sample Information & Notes 

In Chapter 5 we described that the Sample Information & Notes window contains important information 

for record keeping and that the contents can be edited and annotated by a simple procedure:  

1. Right Click while the cursor is positioned within the Information & Notes pane. 

 

 

 

 

 

 

 

 

2.  Click on the Edit Notes button that appears. This will open an editing window that permits free form 

entry of additional information: 

 

 

 

 

 

 

 

 

 

 

 

Right click in the pane to launch the Edit Notes button  

The Information & Notes editor screen  
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3.  After editing, click OK  

The editing window will be closed, and the Sample Information & Notes will be updated. 

User Templates for Faster, More Consistent Notes 

For greater uniformity of recordkeeping, and to speed up entering notes, you can recall a stored template 

to assist your data entry.   The software is supplied with two example templates; a formulator template 

and a UV system template. To access these templates, from the toolbar select Configure → User Template 

 

 

 

 

 

 

 

 

 

 

 

Opening a stored User Template to simplify adding notes 

The Default Formulator and UV System templates 
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Creating a Custom User Template 

Alternatively, the EIT 2.0 PowerView Software® III application makes it easy to create your own 

customized template by entering a new template name. You will be prompted to create a new file.  

 

 

If you respond Yes, Windows Notepad will open your new text file for editing. 

 

 

 

 

 

 

 

You may then use the editing and formatting tools in Windows Notepad to create a customized template 

that contains whatever fields you wish, in whatever format you choose.  

 

 

Create a custom template in Notepad 
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For example: 

 

When you are satisfied with you custom template design you can save the template using File → Save 

 

Customized templates that you create and save will appear in the Configure → User Template menu 

 

 

 

The custom Template is available for use 
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Templates are intended to standardize the data you collect, and simplify text entry by allowing you to cut 

and paste their contents into the Information & Notes panels.    

Custom Text Entry  

Common words, terms and abbreviations are also available for cutting and pasting. The PowerView 

Software® III comes with many common terms already loaded, but you can add your own terms, names, 

locations, and other free-form text to ease data entry and assure greater consistency.  

1.  From the main toolbar select Configure → User Text   

 

2.  This will open a table of custom terms: 
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3.  Right click on the table to open the editing sub menu: 

 

The User Text sub-menu allows you to accomplish common tasks such as copying, cutting and pasting 

text, deleting entries, adding (inserting) new entries, and adding optional descriptions for terms. 

The User Text table provides a quick way to annotate your data with commonly used names, locations, 

conditions and other terms.   

 Changing Units of Measurement 

From the Toolbar → Configure selection you may also select → Units  

 

 

Use this dropdown menu to change the units that will be displayed for Power and Energy values. You can 

choose between Watts/cm2 & J/cm2 or mW/cm2 & mJ/cm2. 

Opening the Units dialog box Select the Power, Energy units 
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Advanced Formatting of Plots 

A number of advanced tools are available for formatting the way graphs are displayed.  These tools can 

be accessed by right clicking when the mouse is in the small panes that show the color of the trace.  

 

Below is the main attribute menu and the various sub-menus  

available for each attribute 
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These sub-menus provide tools for setting how each curve is drawn (lines, symbols, connected symbols, 

bars, shaded bars) and the attributes of the plot in terms of color, line style and line width. These 

attributes are set for each individual curve. 

 

 

The Bar Plots menu allows you to use various bar styles to show  
the area under a curve.  For example, here the UVC curve has 
a simple bar format: 
 
 

The Fill command can be used to apply a solid fill either inside 
or outside the graph plots. This is used to highlight plots. 
 

 

 

 

 

The Interpolation tool selects how data points are connected. Choices include no connection, straight 

lines, X-then-Y, Y-then-X and either vertical or horizontal averaging methods. 
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Finally, these sub-menus allow you to change the pointer style, and Export the graph to either the 

Clipboard or a CSV data file suitable for Microsoft Excel® or other statistical analysis program. 
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12. ActiveX Controls 
 

ActiveX control is provided to allow users to develop custom applications that interact with the 

PowerView Software ® III for improved flexibility and versatility.  Repeated tasks may be simplified for 

reduced errors in data-processing operations. 

The activeX example (activeX_example.xlsm) is found at the root installation directory, which is typically 

at the following location: C:\Program Files (x86)\PowerViewIII 

The example file includes a single button which demonstrates extracting all possible data. The file may be 

copied and/or modified to create custom applications for a given purpose. 

 

The ActiveX controls must be enabled before the first use.  To enable the activeX controls on your 

computer, add the DataDownloader Type Library to the References of your VBA project and run the 

“dataDownloader.exe” as an administrator. 

To add the DataDownloader Type Library to the References of a VBA project, go to Tools > References of 

the Visual Basic for Applications window. Select the checkbox next to DataDownloader Type Library and, 

if necessary, set the location to the root installation directory of PowerView Software® III. 

Next, navigate to the root directory of the PowerView Software® III installation using file explorer. Right-

click on the “data downloader.exe” application and select “run as administrator.” 

 

file:///C:/Program%20Files%20(x86)/PowerViewIII
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Appendix A: Commands & Shortcuts 
1. The Main Toolbar Options 

 

  

  

 

 

  

  

 

 

 

 

2. Right-Clicking in the Main Window with Graph by File View 
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Appendix B: Demonstration Data Files 
UV LED Demonstration Data Files 

 

 

 

 

 

  LEDCure Plus II Profiler 

 

 

 

 

 

 LEDCure Plus II Profiler 

 

 

 

 

 

  LEDCure Plus II Profiler 

 

 

 

 

 LEDCure Plus II Profiler 
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Microwave Lamp Demo Files 

 

 

 

 

 UV PowerMAP II  

 

 

 

 

 UV PowerMAP II 

 

 

 

 

 

 UV PowerMAP II 

 

 

 

 

 

 

 UV PowerMAP II 
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 UV PowerMAP II 

 

 

 

 

 

 UV PowerMAP II 
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Arc Lamp Demo Files 

 

 

 

 

 

UV PowerMAP II 

 

 

 

 

UV PowerMAP II 

 

 

 

UV Power Puck II Profiler 

 

 

 

 

 

 UV Power Puck II Profiler 

 


